
 
 
 
 
 
 
 
 
 
 
 
 

HSL-WI5 
APM Bodymaker 

High Speed Front End 
User’s Manual 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Systems Engineering Associates, Inc. 
14989 West 69th Avenue 
Arvada, Colorado  80007 U.S.A. 
Telephone: (303) 421-0484 
Fax: (303) 421-8108 
www.sea-seg.com 
 
03/2004 



   
 

 
 
 
 
 

HSL-WI5 
APM Bodymaker 

High Speed Front End 
User’s Manual 

 
 
 
 
 

Copyright © 2004 Systems Engineering Associates, Inc. 
 
 
 

All Rights Reserved! 
 
 

Revised 23 March 2004 
 
 



WARNING 
 
 
To ensure the equipment described by this User Manual, as well as the equipment connected to 
and used with it, operates satisfactorily and safely, all applicable local and national codes that 
apply to installing and operating the equipment must be followed. This includes the National 
Electric Code in the USA and other applicable legislation, regulations, and codes in practice 
elsewhere. Since codes can vary geographically and can change with time, it is the user’s 
responsibility to determine which standards and codes apply, and to comply with them. 
 
FAILURE TO COMPLY WITH APPLICABLE CODES AND STANDARDS CAN RESULT IN 
DAMAGE TO EQUIPMENT AND/OR SERIOUS INJURY TO PERSONNEL. 
 
Persons supervising and performing installation or maintenance must be suitably qualified and 
competent in these duties, and should carefully study this User Manual and any other manuals 
referred to by it prior to installation and/or operation of the equipment. 
 
 
The contents of the User Manual are believed to be correct at the time of printing; however, no 
responsibility is assumed for inaccuracies. In the interests of a commitment to a policy of 
continuous development and improvement, the manufacturer reserves the right to change the 
specification of the product or it’s performance or the contents of the User Manual without notice. 
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This section describes the features of the HSL-WI5. This includes a 
functional description, alarms detected and a description of the 
interlocks between the HSL-WI5 and the existing control system. 
 
 
________________________________________________________ 
1.1 FEATURES 
 
• Performs the high-speed control functions of the APM Bodymaker 

to speeds in excess of 500 CPM. This includes clutch control, 
cupfeed control, air strip control and short can detection. 

 
• Rapid response control of clutch/brake system for emergency 

stops die protection) as well as precise BDC stops. The clutch 
solenoid outputs of the HSL-WI5 are not intended as safety 
contacts for the bodymaker clutch and must not be the only 
interrupt to the clutch solenoids. 

 
• Accurate short can detection to a resolution of 1/4” can length. 
 
• Highly repeatable air strip control to reduce can stripping and 

blow out problems. 
 
• Reliable timed cupfeed control to insure proper cup loading and 

protection from misloads. 
 
• Brake Wear compensation (Auto BDC timing programming) 

algorithm to stop press at BDC regardless of brake response. 
Brake response determination allows displaying of actual brake 
response (in degrees). Brake response alarm to indicate when 
brake-stopping response (in degrees) has exceeded user preset 
limit. 

 
• Trimmer speed reference (0-10volt analog output) provides 

reference to trimmer proportional to speed of bodymaker (user 
scalable). 

 
• Alarm detection: short can detection, die sensor fail alarm, timing 

signal fail detection, clutch output failure detection, no ram 
motion alarm, resolver failure detection, and brake response too 
long alarm. 
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• Data Acquisition: Total number of good cans produced and total 
number of short can faults (for both current shift and last shift). 

 
• Built-in 2 Line X 40 character sealed display with 24 key 

membrane keypad allows local viewing of collected data (good 
can count, short can count, brake response) and set-up of all user 
variables (key switch enabled). 

 
• Interfaces directly with the machine-mounted resolver, short can 

sensor, flywheel motion sensor and all clutch, cupfeed, and air 
strip solenoids. 

 
• Based on the high performance M4500 PLC/PLS module, that 

allows easy trouble-shooting and user customization using 
SYSdev program development software. 

 
• Built-in PLS provides all machine timing, eliminating need for  an 

additional PLS. 
 
 
________________________________________________________ 
1.2 FUNCTIONAL DESCRIPTION 
 
The HSL-WI5 bodymaker high-speed logic module is an electronic 
upgrade for the APM bodymaker that performs the high-speed control 
functions including: rapid response clutch/brake control, accurate 
short can detection, reliable cupfeed and precise air strip control. In 
addition, the brake wear compensation feature automatically adjusts 
the BDC timing signals to stop the press at BDC regardless of brake 
stopping time. 
 
Alarm detection is provided including:  

• Short Can Detection 
• Die Sensor Failure Detection 
• Timing Signal Failure 
• Brake Response Too Long Alarm 

 
Data collection includes (both for the current shift and previous (last) 
shift):  

• Total Good Can Count 
• Short Can Faults Count 
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Interfaces directly to:  
• The Machine Mounted Resolver 
• Short Can Sensor 
• Clutch/Brake Solenoids 
• Cupfeed and Air Strip Solenoids 
• Host PLC via Discrete DC I/O. 

 
 
________________________________________________________ 
1.3 CLUTCH CONTROL 
 
The clutch solenoids are activated by the HSL-WI5 through the 
electro-mechanical two-hand control circuitry provided externally by 
the user. The throughput of the HSL-WI5 is 0.5 milliseconds. This 
fast throughput, along with a fully integrated PLS, allows extremely 
fast and repeatable de-clutching/braking response to be achieved.  
 
Outputs from the host PLC to inputs of the HSL-WI5 control the 
clutch solenoids. The detection of any alarm (short can fault, die 
sensor failure, etc.) will result in an immediate de-clutch of the 
solenoids. 
 
The M4500 incorporates a built-in PLS which interfaces directly with 
the machine-mounted resolver and provides all machine timing, 
eliminating the need for an external PLS. 
 
Six discrete DC inputs to the HSL-WI5 are used to control the clutch:  

1. “Clutch ON (IMED)” 
2. “Clutch ON (BDC)”  
3. “Run Mode (not Bar)” 
4. “Continuous Mode” 
5. “Single Mode” 
6. “Inch Mode” 

 
Note:  The “Clutch ON (IMED)” and “Clutch ON (BDC)” inputs 
must be turned “ON” simultaneously (within 0.5 seconds) in order for 
the clutch to activate. 
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________________________________________________________ 
1.3.1 CLUTCH CONTROL VIA HOST PLC 
 
The following description of operation defines the requirements of the 
host PLC logic to activate the clutch through the HSL-WI5: 
 
Continuous Mode:  Continuous mode is selected when the “Run 

Mode” and “Continuous Mode” inputs are ON and the “Single 
Mode” and “Inch Mode” inputs are off.  Turning both the “Clutch 
ON (IMED)” and “Clutch ON (BDC)” inputs ON simultaneously 
will activate the clutch. 

 
BDC Stop:  To perform a BDC stop, turn the “Clutch ON 
(BDC)” input off while leaving the “Clutch ON (IMED)” input 
ON. 

 
Immediate Stop:  To perform an immediate or emergency stop, 
turn both the “Clutch ON (BDC)” and “Clutch ON (IMED)” 
inputs off simultaneously. This will indicate to the HSL-WI5 that 
the clutch should be disengaged immediately and not wait for the 
BDC timing signal. 

 
Single Mode:  Single mode is selected when the “Run Mode” and 

“Single Mode” inputs are ON and the “Continuous Mode” and 
“Inch Mode” inputs are off.  Turning both the “Clutch ON 
(IMED)” and “Clutch ON (BDC)” inputs ON simultaneously for 5 
to 50 milliseconds will activate the clutch and the press will make 
one stroke. 

 
Inch Mode:  Inch mode is selected when the “Run Mode” and “Inch 

Mode” inputs are ON and the “Continuous Mode” and “Single 
Mode” inputs are off.  Turning both the “Clutch ON (IMED)” and 
“Clutch ON (BDC)” inputs ON simultaneously will activate the 
clutch as long as both inputs are ON. 

 
Bar Mode:  Bar mode is selected when the “Run Mode” input is off.  

Turning both the “Clutch ON (IMED)” and “Clutch ON (BDC)” 
inputs ON simultaneously will activate the clutch will activate the 
clutch as long as both inputs are ON. 

 
Refer to the schematic at the back of this manual for typical HSL-WI5 
clutch connections. 
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IMPORTANT SAFETY WARNING –  
The HSL-WI5 is intended as a high-speed logic gate to provide 
consistent and accurate clutch control. It is not designed as a 
redundant, dual-processor clutch brake safety module.  
 
The HSL-WI5 must not be the only means of controlling the 
clutch mechanism. Good design practice dictates the use of 
safety interlocks on any device that starts or stops 
automatically that can cause personnel injury to operating or 
maintenance personnel.  
 
The HSL-WI5 must be used only in conjunction with industry 
approved safety interlock contacts, implemented in accordance 
with ANSI B11.1 safety requirements; otherwise, serious 
personnel injury may result. 
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________________________________________________________ 
1.4 CUPFEED SOLENOID CONTROL 
 
The HSL-WI5 provides control for both the cupfeed ON and off 
solenoids. For auto operation, the cupfeed is enabled by the host PLC 
via a discrete input to the HSL-WI5. The cupfeed is timed ON and off 
with the cupfeed timing signal to provide accurate cup loading. The 
manual cupfeed input is provided to activate the cupfeed as long as 
the manual input is ON. 
 
Control Of Cupfeed Solenoid Via Host PLC: Two discrete DC 
inputs to the HSL-WI5 from the host PLC are used to control the 
cupfeed solenoid:  

1. “Cupfeed Auto Enable” 
2. “Cupfeed Manual” 

 
The following description of operation defines the requirements of the 
host PLC logic to activate the cupfeed through the HSL-WI5: 
 
Cupfeed Auto Mode:  In single and continuous modes, the cupfeed 

is gated ON with the leading edge of the cupfeed timing signal 
(CH04) and gated off with the trailing edge of the cupfeed timing 
signal. The cupfeed is opened after two strokes when the 
“Cupfeed Auto Enable” input is turned ON and the leading edge 
of CH04 occurs. This allows three strokes of air strip to clear the 
punch of coolant before the first can is made. The cupfeed is 
closed when the “Cupfeed Auto Enable” input is turned “off” and 
the trailing edge of CH04 occurs. 

 
Note: It takes two strokes once the cupfeed is opened for the first 
can to travel through the positive cupfeed and is punched.  Once 
the cupfeed is closed, it requires two strokes to punch the last two 
cups, which are in process of traveling through the positive 
cupfeed. 

 
Manual Mode:  The cupfeed can be activated directly (manually) by 
activating the “Cupfeed ON Manual” input. With the machine 
stopped, activating the “Cupfeed ON Manual” input opens the 
cupfeed. When the “Cupfeed ON Manual” input is off, the cupfeed is 
closed. With the machine running, activating the manual cupfeed 
feeds one cup with the corresponding three strokes of air strip prior to 
making the cup. 
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________________________________________________________ 
1.5 AIR STRIP CONTROL 
 
The HSL-WI5 provides a repeatability of 0.5 milliseconds for the air 
strip thus reducing can stripping and blow out problems. Both an “Air 
Strip (Low)” and “Air Strip (High)” timing signal are provided to 
activate the air strip two stokes prior to the cupfeed open (when the 
press is running). 
 
 
________________________________________________________ 
1.6 BRAKE WEAR COMPENSATION 
 
The HSL-WI5 incorporates a brake wear compensation or automatic 
BDC timing feature. This stops the press at BDC regardless of the 
actual braking response of the clutch/brake. This is accomplished by 
automatically adjusting the BDC timing signal based on the previous 
stopping response. Any overrun is detected and a new BDC timing 
signal is computed such that the machine will stop at the desired 
location on the next stop. Two BDC signals are provided, one for 
“Continuous/Single” modes and one for “Inch” mode. The appropriate 
BDC timing signal is adjusted based on the mode of the machine 
when a BDC stop is initiated. 
 
The actual brake response (in degrees) is calculated. This is the 
number of degrees from where the clutch was de-activated (BDC 
timing location) to the position where the crankshaft actually stopped. 
This can then be displayed on the Keypad/Display to determine the 
condition of the brake. 
 
A “Brake Response Too Long” alarm is generated when the actual 
brake response exceeds a user specified maximum allowed brake 
response. This can be used to indicate that service to the brake should 
be performed. 
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________________________________________________________ 
1.7 ALARM DETECTION 
 
The HSL-WI5 detects the following additional alarms:  
 
Short Can Detection:  The “Short Can Check” timing signal 
(CH02), along with the machine mounted short can sensor, is used to 
verify the entire length of the can. The short can sensor must see can 
the entire time the “Short Can Check” timing signal (CH02) is ON. If 
the can is short (tear off) or any void is detected, the short can alarm is 
generated and the cupfeed is immediately closed. The resolution of 
the short can check is 0.5 milliseconds. At a machine speed of 
250CPM, this translates to approximately 1/4” resolution in can 
length. The “Short Can” alarm output must be interlocked to the 
existing control system to dis-engage the clutch immediately. 
 
Die Sensor Failure:  This alarm occurs when the short can sensor 
fails ON. The “Sensor Check” timing signal (CH03) is used to verify 
that the short can sensor does indeed turn off when a can is not 
present. 
 
Timing Signal Fail: The timing signal fail occurs when any of the 
timing signals generated in the PLS section fail to change state 
periodically while the machine is running. This alarm activates the 
“Can Sensor/Timing Fail” output. 
 
Brake Response Too Long: The “Brake Response Too Long” 
alarm is generated when the actual brake response exceeds a user 
specified maximum allowed brake response. This can be used to 
indicate that service to the brake should be performed. 
 
The above alarms are available to the host PLC via discrete outputs. 
These should be used to stop the machine and indicate the problem 
when any one of the alarms occurs. 
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________________________________________________________ 
1.8 INTERLOCKS TO EXISTING CONTROL SYSTEM 
 
In addition to the alarms listed in section 1.7, the following (+24VDC 
discrete signals) should be interlocked to the existing control system: 
 
Clutch ON:  This signal is provided to the host PLC to indicate when 
the clutch solenoids are ON. 
 
Pulse Train (3-PPS):  This pulse train signal gives three pulses per 
stroke.  It is provided to the host PLC to check for ram motion once 
the clutch solenoids have been engaged. 
 
Logic Sync (CH07):  This signal will provide the host PLC with 
one pulse per stroke.  It is based on the state of timing channel CH07 
(PLC Clock Timing).  It is generally set for 180 degrees on, 180 
degrees off. 
 
Flywheel at Bar Speed:  This signal is provided to determine 
flywheel zero speed.  This output is set when there is no motion 
detected by the main crank resolver.  
 
Flywheel at Inch Speed:  This output is set when the RPM of the 
resolver is above the bodymaker Low Speed threshold set-point. 
 
Flywheel at Punch Speed:  This output is set when the RPM of 
the resolver is above the bodymaker High Speed threshold set-point.  
 
Cupfeed is Open:  This signal is provided to the host PLC to 
indicate that the cupfeed is open and the bodymaker is in production. 
 
________________________________________________________ 
1.9 INTERLOCKS FROM EXISTING CONTROL SYSTEM 
 
In addition to the clutch control interlocks described in section 1.3 and 
the cupfeed control interlocks described in section 1.4, the following 
interlocks should be provided by the existing control system: 
 
End Of Shift:  This signal is used transfer the “Current Shift” data  
to the “Last Shift” data.  
 
Alarm Reset:  This signal is used to reset the alarms generated by 
the HSL-WI5. 
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________________________________________________________ 
1.10 DATA COLLECTION 
 
The following data is collected for both the current shift and the 
previous (last) shift: 
 
 1) Total number of good cans produced 
 2) Total number of short can faults 
 
This data can be viewed locally on the Keypad/Display.  This 
information is updated (“current” shift transferred to “Last” shift) 
based on the change of state of the “End of Shift” input. 
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The HSL-WI5 module is provided for door mounting on the existing 
user's control cabinet door or console. 
 
 
________________________________________________________ 
2.1 WHAT’S INCLUDED 
 
Verify that the following items are included when unpacking the 
HSL-WI5 (back-panel mounting): 
 
1ea. HSL-WI5 back-panel for mounting in existing control cabinet 

(includes the following): 
 

1ea. M4500 PLC/PLS Module with required I/O boards 
1ea. P4500 Power Supply 
1ea  D4591 Display with ribbon cable for mounting in the 

existing control cabinet door 
1ea. HSL-WI5 User's Manual 
1ea. M4500 User's Manual 
1ea. HSL-WI5 Program Disk 

 
The following items are optional items and can be purchased 
separately as required or desired: 
 

1ea. RSV34-MS1 Resolver 
1ea. RSV-RSCBLE-XX Resolver Cable 

 
 
________________________________________________________ 
2.2 POWER REQUIRED 
 
The HSL-WI5 is powered from 115/230VAC 50/60HZ and +24VDC. 
The 115/230VAC is used to power the P4500 power supply while the 
+24VDC is used to power the +24VDC I/O (sensors, clutch solenoids, 
etc.).  
 
Note: +24VDC solenoids must be used for all clutch, cupfeed, and 
air strip solenoids. These provide a much more consistent and 
repeatable response time than 115VAC solenoids. Assuming +24VDC 
solenoids were used in the existing system, the +24VDC current 
required by the HSL-WI5 is no more than the existing systems 
+24VDC current requirement therefore the existing +24VDC power 
supply should be adequate. 
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________________________________________________________ 
2.3 MOUNTING AND WIRING THE HSL-WI5 
 
The HSL-WI5 control panel should be mounted in the existing control 
cabinet. Perform the following steps to mount the HSL-WI5: 
 
Refer to the “Recommended Cut-Out” in figure 1. Create a cut-out in 
the door of the existing control cabinet and mount the D4591 
Keypad/Display and connect the ribbon cable from the M4500 to the 
display. 
 
Note:  The Keypad/Display must be located within 6 feet of the 
M4500 to avoid EMI pick-up on the display ribbon cable. 

 
 

________________________________________________________________________________ 

 
 

Figure 1 –Recommended Panel Door Cut-out 
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Referring to the electrical control schematic at the back of this 
manual, wire the HSL-WI5 as follows: 
 
Note: Keep all +24VDC wiring, resolver cable, and trimmer speed 
reference wiring away from high voltage wiring. Wire the machine-
mounted resolver directly to the 8-pin resolver input connector on the 
M4500. 
 
1) Incoming Power: 115VAC-230VAC to FU1, neutral to 900 and 

ground to GND. Logic power (+24VDC) to 501 and common to 
500. Control power (+24VDC) to 601 and common to 600. 

 
2) Interlocks from existing control system to HSL-WI5 (terminals 

I14 through I23). 
 
3) Interlocks to existing control system from HSL-WI5 (terminals 

O10, O15 through O24) and FLT output. 
 
4) Wire the Clutch Solenoids to O10 and O11 (see note 2 of the 

electrical control schematics). Wire the Cupfeed and Air Strip 
solenoids to FU4 through FU6. 

 
5) Short Can Sensor (I08) and Flywheel Motion Sensor (I10) using 

three conductor shielded cable. The shield of the sensor cable 
should be tied to earth ground at a terminal inside the existing 
control cabinet and left floating at the sensor. 

 
6) Set-Up Enable key switch (if desired). 
 
7) Resolver cable from resolver or existing PLS to RO-S4 connector 

on M4500 using a three pair, two-conductor shielded cable. The 
shield of the resolver cable should be tied to the “SHLD” terminal 
of the resolver input connector. Make sure the resolver cable 
shield is left floating at the resolver. 

 
8) Trimmer Speed reference (0-10Vdc) analog output to trimmer 

drive (if used), using two conductor shielded cable. It may be 
necessary to use an analog isolation amplifier (not provided) to 
isolate the drive from the M4500 to prevent damage to the 
module. 
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________________________________________________________ 
2.4 MOUNTING THE RSV34-MS1 RESOLVER  
(IF REQUIRED) 
 
The HSL-WI5 is designed to interface to a resolver (not encoder) for 
machine timing. If the machine is not already equipped with a 
resolver, then the existing encoder will have to be removed and an 
RSV34-MS1 resolver will have to be mounted in it's place. If this is 
the case, refer to the RSV34-MS1 data sheet for details on mounting 
the resolver. Use the RSV-RSCBLE cable to connect the resolver to 
the HSL-WI5. Route the resolver cable in a separate conduit, away 
from all other high voltage and control wiring. Wire the cable directly 
to the 8-pin resolver connector on the HSL-WI5 (see section 2.3). 
 
 
________________________________________________________ 
2.5 HSL-WI5 SOFTWARE INSTALLATION 
 
The HSL-WI5 set-up software is used to  
• Download the Program to the M4500 
• Tune (Set-Up) the User Adjustable Variables 
• Download and Upload (Save) the User Set-Up Variables to Disk 
• View Shift Data  
 
Follow the steps below to install either the HSLWI5 setup program 
and PLC application program on a PC used to support the HSL-WI5 
control system. 
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________________________________________________________ 
2.5.1 SETUP PROGRAM INSTALLATION 
 
The HSMWI5 setup program is compatible with Windows 
95/98/ME/2000/XP operating systems. 
 
To install the set-up software, perform the following steps: 
 
1) Insert the HSL-WI5 CD into the drive 
 
2) From the Windows desktop, “Click” Start and then select run. 
 
3) From the “Run” dialog box, “Click” the Browse button. Select the 

drive with HSL-WI5 CD.  Select the “setup.exe” file and “Click” 
Open and then Ok. 

 
4) This will initiate the installation process.  Follow the instructions 

that appear on the screen to complete the installation process.  The 
HSMWI5 setup program can be executed from the “Systems” 
folder located in Programs. 

 
 
________________________________________________________ 
2.5.2 SYSDEV PROGRAM DEVELOPMENT SOFTWARE 
INSTALLATION 
 
The SYSdev Program Development software is used to perform on-
line trouble-shooting and program modifications to the HSL-WI5. If 
SYSdev was purchased with the HSL-WI5 package and is not already 
installed on the your computer, install SYSdev onto the hard drive of 
your computer following the steps in the SYSdev Program 
Development manual. 
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________________________________________________________ 
2.5.3 APPLICATION PROGRAM INSTALLATION 
 
The application program is a SYSdev based program, loaded into the 
M4500 module and performs the HSL-WI5 logic. The program is 
written in a combination of Ladder logic and High-level. If the user 
desires to make program changes or perform on-line monitoring of the 
program execution the files, which constitute the HSLWI5 program, 
will have to be loaded onto the hard drive of the PC used to support 
the system. The SYSdev Program Development Software will also 
have to be loaded on the PC. To install this program perform the 
following: 
 
1) Install the “PROGRAMS” disk into the drive.  
 
2) Create one directory off the root directory of the PC for the files 

that makeup the HSLWI5 application program. 
 
3) Copy all the files from the program disk to this subdirectory. 
 
 
________________________________________________________ 
2.6 MODIFY EXISTING PLC PROGRAM 
 
Modify the existing control system PLC program to interface with the  
HSL-WI5 by incorporating the following into the existing PLC ladder 
logic: 
 
1) The HSL-WI5 now controls the clutch BDC stop, cupfeed, air 

strip, and short can detection. Defeat the existing short can 
detection in the PLC and add the following alarm inputs from the 
HSL-WI5: 
• “Short Can” (O18) 
• “Can Sensor/Timing Fail” (O19) 
• “Brake Response Too Long” (O20) 

 
Note:  These alarms must immediately disable the clutch logic in 
the PLC. The alarms are true logic (“on” when alarm detected). 
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2) Add the following inputs into the PLC logic: 
• Clutch ON (O10):  This signal indicates the state of the 

clutch solenoids. 
• Pulse Train 3-PPS (O16):  This pulse train signal gives 

three pulses per stroke.  It is intended as a check for ram 
motion once the clutch solenoids have been engaged. 

• Logic Sync CH07 (O17):  This signal is based on the state 
of timing channel CH07 (PLC Clock Timing). It provides the 
host PLC with one pulse per stroke and is generally set for 180 
degrees on, 180 degrees off. 

• Flywheel at Bar Speed (O21):  This signal is set when 
there is no motion detected by the main crank resolver.  

• Flywheel at Inch Speed (O22):  This signal is set when 
the RPM of the resolver is above the bodymaker Low Speed 
threshold set-point. 

• Flywheel at Punch Speed (O23):  This signal is set when 
the RPM of the resolver is above the bodymaker High Speed 
threshold set-point.  

• Cupfeed is Open (O24):  This signal is provided to the host 
PLC to indicate that the cupfeed is open and the bodymaker is 
in production. 

 
3) Add the “Clutch ON (IMED)” and “Clutch ON (BDC)” outputs 

into the PLC logic. In general, these can be derived from the logic 
that use to drive the clutch solenoids by removing the BDC timing 
signal from the original logic.   

 
Both outputs should come on simultaneously to engage the clutch.  
To perform an immediate or emergency stop, turn off the “Clutch 
ON (IMED)” signal.  To perform a BDC stop, turn off the “Clutch 
ON (BDC)” signal.  In either case removal of either signal will 
disengage the clutch. 

 
4) Add the “Run (not Bar)” mode output to the existing PLC logic. 

This signal should be ON to run the machine in either continuous, 
single or inch modes and should otherwise be off. 

 
5) Add the “Continuous”, “Single”, and “Inch” mode outputs to the 

existing PLC logic. The respective output should be ON when the 
corresponding mode is selected when in “Run” (not Bar) mode. 
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6) Add the “Cupfeed On” output into the PLC program. In 
continuous and single modes, this signal should be the summation 
of the cupfeed auto mode and all line control stand-by conditions 
(when “on”, the cupfeed will be timed opened by the HSL-WI5 
when the machine is running and  feed cups in the normal 
production mode). In inch mode, the  cupfeed will be opened when 
this output is “on”. 

 
7) Add the “Cupfeed Auto Enable” output to the PLC program. This 

must be ON to open the cupfeed in normal production. 
 
8) Add the “Cupfeed ON Manual” output to the PLC program. With 

the machine stopped, activating the “Cupfeed ON Manual” input 
opens the cupfeed. When the “Cupfeed ON Manual” input is off, 
the cupfeed is closed. With the machine running, activating the 
manual cupfeed feeds one cup with the corresponding three 
strokes of air strip prior to making the cup. 

 
9) Add the “Alarm Reset” output to the PLC program. This signal 

should be “on” as long as the system reset push-button is 
depressed. 

 
10) Add the “End of Shift” output to the PLC program. This signal is 

used transfer the “Current Shift” data to the “Last Shift” data at 
the end of an eight or twelve hour period. 
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________________________________________________________ 
2.7 HSL-WI5 SET-UP 
 
The HSL-WI5 is shipped from the factory with the PLC program 
“HSLWI5” loaded in the PLC section of the HSL-WI5 module and 
the PLS channel set-point file “WI5TMG” loaded in the PLS section. 
In most cases, the following user variables and timing channels may 
have to be altered to tune the HSL-WI5 to the actual bodymaker it is 
controlling. 
 
Once the HSL-WI5 is installed and the control system is powered 
back up, perform the following to set-up and tune the HSL-WI5. The 
set-up is performed using the Display/Keypad or a PC running the 
“HSLWI5” set-up program. See section 3 for a description of the 
Keypad commands and menu displays of the HSL-WI5 Keypad/ 
Display. See section 4 for a description of the menus, variables and 
how to use set-up program.  
 
 
________________________________________________________ 
2.7.1 DEFAULT SET-UP VARIABLES 
 
As shipped, the set-up variables for the M4500 main processor are set 
to the following defaults: 
 
 Brake Wear Compensation: 
  Enabled  : Y 
  Desired BDC Stop Position (cont./single)  : 000° 
 
 Maximum Allowed Stopping Response  : 350° 
 
 Bodymaker Running Speeds: 
  Low Speed (SPM)  : 175 
  High Speed (SPM)  : 350 
 
 Number of Cupfeed Open/Initial Air Strip Strokes: 
  Number of Strokes Before Cupfeed Open  : 2 
  Number of Cans Made with Initial Air Strip  : 20 
 
 Trimmer Speed Reference: 
  Maximum Speed  : 375 
  Idle Speed (W/I stopped)  : 250 
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The “WI5TMG” timing channel file, as shipped, contains the 
following default timing set points: 
 
 CHAN ON - OFF DESCRIPTION 
 
 CH00: 150 – 170 BDC (Cont./Sing) timing 
 CH01: 200 – 220 BDC (Inch) timing 
 CH02: 155 – 175 Short Can Check timing 
 CH03: 110 – 130 Sensor Check timing 
 CH04: 150 – 350 Cupfeed timing 
 CH05: 150 – 200 Air strip (Normal) timing 
 CH06: 120 – 190 Air strip (Initial) timing 
 CH07: 180 – 000 PLC Clock Timing 
 
 
________________________________________________________ 
2.7.2 VERIFY MAIN CRANK RESOLVER 
 
Using the Keypad/Display, press the “Set-up” key and select option 3 
“Set Machine Timing” (see section 3.4.3). Verify that the main crank 
resolver direction is correct and linear by barring or inching the 
machine forward. The position (POS) should increment linearly 
through the range of 0 to 359. If the direction is backwards, reverse 
the S1 and S3 leads where the resolver cable connects to the M4500. 
If the position is not linear (increments up then down or does not 
increment through full range), verify that the resolver leads are all 
connected and connected correctly.  Refer to the electrical control 
schematics at the back of the manual for wiring details. 
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________________________________________________________ 
2.7.3 SET BODYMAKER SET-UP PARAMETERS 
 
The Bodymaker set-up parameters include:  
1) Enabling or Disabling the Brake Wear Compensation 
2) Setting the Desired Stopping Points (if the brake wear 

compensation is enabled) 
3) Setting the Maximum Allowed Stopping Response 
4) Setting the Bodymaker Running Low and High Speeds 
5) Setting the Number of Strokes before the Cupfeed Opens and 

Number of Cans Made With Initial “Air Strip” 
 
Brake Wear Compensation: If the brake wear compensation is to 

be used, enable it by setting the “Brake Wear Compensation 
Enable” to “Y” and set the “Desired BDC Stop Position 
(cont./single)”. The desired BDC stop position is the desired 
location of the ram when it comes to rest after a BDC stop. The 
desired stopping position is generally set to 000 degrees. Enabling 
the brake wear compensation allows the M4500 to automatically 
adjust the BDC timing channel (CH00-Cont./Single) as necessary 
such that the press will stop at the desired stopping position 
regardless of the actual brake response. 

 
If the brake wear compensation is not to be used, disable it by 
setting the “Brake Wear Compensation Enable” to “N”. Disabling 
the brake wear compensation requires the BDC timing (CH00) 
signal to be set manually such that the press stops at BDC.  

 
Note: If the brake response then changes, the press will not stop 
at the desired position if the brake wear compensation is disabled. 

 
Maximum Allowed Stopping Response: This parameter defines 

the maximum allowed brake response before the “Brake Response 
Too Long” alarm is generated. If the actual brake response 
(number of degrees from when the brake is activated to the 
position where the press ends up at rest) when a BDC stop is 
performed is longer than this number, the alarm is generated. If 
the actual brake response is less, the alarm is not generated. Set 
this parameter to the value where the brake response is considered 
too long and service to the brake should be performed (typically 
270 to 350 degrees). 
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Bodymaker Running Speeds: Set the Bodymaker running “Low 
Speed” and “High Speed” to the speeds that the bodymaker will 
actually run at when the respective speed is selected.  

 
Note:  This is not a speed reference that will make the bodymaker 
run at the speeds entered but is instead simply parameters used by 
the M4500 to know when to switch between the “High” and 
“Low” speed settings. 

 
Number of Strokes before Cupfeed Open:  This is the number 

of strokes (plus 2) that the machine will make with air strip once 
the cupfeed is enabled, before it actually opens.  This allows 
coolant to be blown from the ram to prevent “Hydraulic Lock” 
(normally set to 2). 

 
Number of Cans made with Initial Air Strip:  This is the 

number of cans made using the CH06 – “Initial Air Strip” timing 
channel when the cupfeed is first opened before switching to 
CH05 – “Normal Air Strip”.  This allows the first cans to made 
with more “Air Strip” while the tooling is cool. 

 
See section 3 “Using the Keypad/Display” or section 4 “HSLWI5 Set-
up Program Reference” for details on setting the above set-up 
parameters. 
 
 



SECTION 2 
INSTALLATION 

 
HSL-WI5 User’s Manual SYSTEMS Electronics Group 

 
- 23 - 

________________________________________________________ 
2.7.4 SET TRIMMER SPEED REFERENCES 
 
Set both the “Trimmer Maximum Speed” and “Trimmer Idle Speed” 
as desired. These two parameters are used to control the speed 
reference (0-10VDC) to the trimmer. 
 
Trimmer Maximum Speed: The “Trimmer Maximum Speed” 

parameter is used to scale the 0-10VDC analog output such that 
when the bodymaker is running at the speed entered in “Trimmer 
Maximum Speed”, the analog output will be at 10 volts. 

 
Trimmer Idle (Minimum) Speed: This parameter determines the 

speed the trimmer will run at when the bodymaker is stopped (de-
clutched).  

 
Note:  When the bodymaker is running, the trimmer speed reference 
is proportional (as set by the “Trimmer Maximum Speed” scaling) to 
the speed of the bodymaker. This parameter is used to provide the 
speed reference when the bodymaker speed is zero. 
 
See section 3 “Using the Keypad/Display” or section 4 “HSLWI5 Set-
up Program Reference” for details on setting the above set-up 
parameters. 
 
 
________________________________________________________ 
2.7.5 SET MACHINE ZERO 
 
Inch the main crank of the bodymaker to back dead center (BDC) and 
set the M4500 offset using the D4591 Keypad/Display. 
 
1) Press the “Set-up” key and select option 4 “Zero Machine (set 

resolver offset)”, see section 3.4.4. 
 
2) Enter “0” to set the resolver offset. The timing set-up menu will 

then be displayed, showing the “POS:” at zero. The M4500 
calculates the actual offset value required to make this the zero 
position and displays this number in the offset field. 

 
3) Return to the primary set-up menu by pressing <ESC>. Return to 

the default screen by pressing <ESC> again. 
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________________________________________________________ 
2.7.6 VERIFY LOCATION OF SHORT CAN TIMING (CH02) 
 
Inch the machine and verify that the “Short Can” timing (CH02) of 
the M4500 first turns ON when the short can sensor is over the nose 
of the punch on the forward portion of the stroke. This would be 
where the sensor would first “see” the can as it emerges from the die 
set. Verify that the “Short Can” timing turns “off” right before the 
sensor would quit seeing the lip of the can as the ram continues it's 
forward motion. Adjust either or both of the ON or off locations of 
CH02 until the above is achieved. Depending on the location of the 
short can sensor, CH02 is typically set ON at 155 degrees and off at 
175 degrees. 
 
 
 

________________________________________________________________________________ 
 
 
 

 
 
 

Figure 2 – Short Can Check Timing Sequence 
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Note:  The short can sensor must “see” can the entire time the “Short 
Can” timing (CH02) is ON in order to pass the short can check, 
otherwise the “Short Can” alarm will be generated. 
 
Verify that the “Sensor Check” timing (CH03) is set correctly. This 
timing signal should go ON for 20 degrees then off prior to the punch 
emerging from the die set (typically 110 to 130 degrees). This signal 
is used to verify that the short can sensor has not failed ON and 
therefore the short can sensor must be off the entire time CH03 is ON 
otherwise the “Die Sensor Fail” alarm is generated. 
 
See section 3 “Using the Keypad/Display” or section 4 “HSLWI5 Set-
up Program Reference” for details on setting CH02 and CH03. 
 
 
________________________________________________________ 
2.7.7 VERIFY SINGLE CUPFEED 
 
With the machine running in continuous mode and the “Cupfeed Auto 
Enable” off, feed a single cup through the machine by depressing the 
“Cupfeed ON Manual” push-button. The cupfeed solenoid should 
open for one cup and activate the air strip for three strokes prior to the 
can being punched (can punched on fourth stroke). Verify the cupfeed 
timing (CH04), air strip timing (CH05 and CH06), and short can 
timing (CH02). Adjust as necessary to achieve smooth cupfeed 
operation with no false short can shut downs. 
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________________________________________________________ 
2.7.8 VERIFY MACHINE OPERATION 
 
Run the machine in normal production. 
 
Verify Air Strip Timing: With the machine running and the cupfeed 

open, adjust the respective “Air Strip” timing (CH05-Normal, 
CH06-Initial) and verify that the cans are stripped without any 
problems. See section 3 “Using the Keypad/Display” or section 4 
“HSLWI5 Set-up Program Reference” for details on adjusting 
CH05 and CH06. 

 
Verify Short Can Timing: With the machine running and the 

cupfeed open, verify that no false short can faults are occurring 
(short can alarm occurs when full length can is made). If a false 
short can alarm are occurs, narrow the short can timing window 
one degree at a time until false short can alarms are no longer 
generated. 

 
Verify that the short can detection is working correctly by 
generating a short can and verifying that the short can alarm is 
generated. This can be done by stopping the press, removing one 
of the die rings, then punching a cup in single stroke mode. The 
short can alarm should be generated when the cup is punched. 

 
Verify BDC Stop: If the brake wear compensation is enabled, verify 

that the press does stop at the desired location.  
 

Note:  When the system is first installed, it will take a few 
successive stops for the algorithm to program the BDC timing 
channel to the correct position. The compensation is enabled after 
the press has been running at a fixed speed in continuous. The 
BDC timing channel will not be modified when single strokes are 
made or if press is started in continuous and then immediately 
stopped again. Wait about 5 seconds after the press is started 
before performing the BDC stop to verify the stop position. 

 
If the brake wear compensation is disabled, manually adjust both 
the BDC (Cont./Single) timing (CH00) and the BDC (Inch) timing 
(CH01) such that the press stops at back dead center at both 
respective speeds. See section 3 “Using the Keypad/Display” or 
section 4 “HSLWI5 Set-up Program Reference” for details on 
adjusting CH00 and CH01. 
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Verify BDC Stop Sequence: Perform a normal manual BDC stop 
while the cupfeed is open and verify that the cupfeed closes. The 
machine should make two extra strokes processing the two 
remaining cups in the cupfeed cam and stop at BDC with no cups 
in the cup locator or cupfeed cam. This sequence should be true 
for standby stops and BDC alarm stops as well. 

 
 
The Machine is Now Set-Up and Ready to Run! 
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________________________________________________________ 
2.8 M4500/P4500/D4591 INSTALLATION 
 
The following is provided as a reference only. These steps are 
performed by the factory prior to shipping the HSL-WI5. These steps 
need only be performed in the event either the M4500 module, P4500 
power supply, or D4591 display need to be replaced. Refer to the 
M4500 User's Manual for general details on installing the M4500, 
P4500, and D4591. 
 
 
________________________________________________________ 
2.8.1 M4500 MODULE INSTALLATION 
 
To install the M4500 module, perform the following: 
 
1) Remove the cover from the M4500 chassis (retained with three 

captive screws on the lower front of the cover and two captive 
screws on each side of the M4500 chassis). 

 
2) Install the S4563 (SLOT0-0, furthest left slot): Set the slot address 

dip switches (SW1) to the following positions: 
 

S4563:  SW1 switch1 = "OFF" 
SW1 switch2 = "OFF" 

 
3) Install the S4573 (SLOT0-1, slot next to S4563): Set the slot 

address dip switches (SW1) to the following positions: 
 

S4573:  SW1 switch1 = "ON" 
SW1 switch2 = "OFF" 

 
4) Install the on the M4500, making sure all the board connectors 

protrude through the slots in the cover. Tighten the three captive 
screws on the lower front of the cover and the two captive screws 
on each side of the M4500 chassis. 

 
5) Connect the display ribbon cable to the connector on the back of 

the M4500 (the connector will mate with the connector on the 
M4500 only one way). 

 
6) Mount the M4500 chassis to the HSL-WI5 back panel using four 

8-32 screws. 
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7) With power to the P4500 "off", install the P4500 power supply 
cable to the +5/C/+12/C/-12 connector on the M4500 (the 
connector will mate with the connector on the M4500 only one 
way). 

 
8) Install the respective field wiring arms on all the I/O boards of the 

M4500 (I/O slots 0 and 1, resolver connector, and IN0/IN1 
connector). Make sure all field-wiring connectors are fully mated 
to the M4500. 

 
 
________________________________________________________ 
2.8.2 P4500 POWER SUPPLY INSTALLATION 
 
To install the P4500, perform the following steps: 
 
1) Mount the P4500 to the HSL-WI5 in the mounting holes next to 

the M4500 (left side) using two 8-32 screws. 
 
2) With power to the P4500 "off", install the P4500 power supply 

cable to the +5/C/+12/C/-12 connector on the M4500 (the 
connector will mate with the connector on the M4500 only one 
way). 

 
 
________________________________________________________ 
2.8.3 D4591 KEYPAD/DISPLAY INSTALLATION 
 
To install the D4591, perform the following steps: 
 
1) With the gasket installed on the mounting studs of the D4591, 

install the D4591 in the cut-out of existing control cabinet. Secure 
the display to the enclosure using 7ea. 8-32 nuts and external lock 
washers. 

 
2) Connect the display ribbon cable to the connector on the lower 

back of the display. 
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________________________________________________________ 
2.8.4 DOWNLOAD HSLWI5 APPLICATION PROGAM AND 
SET-UP DATA TO M4500 
 
Once the M4500/P4500/D4591 are installed, perform the following to 
download the application program as well as the previously saved set-
up data and timing channel set-points: 
 
1) Power up the M4500 and the PC used to interface with the HSL-

WI5. 
 
2) Connect an RS-232 cable from the computer COM port on the 

computer to the "PROG" port on the M4500. 
 
3) Execute the HSLWI5 setup program. 
 
4) Download the HSLWI5 application program to the M4500, see 

section 4.2.3. 
 
5) Download the previously saved set-up data to the M4500, see 

section 4.2.4. 
 
6) The M4500 is now ready to run, loaded with HSLWI5 application 

program, timing set-points, and set-up data. 
 

Note:  Double check the machine zero position and re-zero the 
resolver if necessary, prior to running the machine. 
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The keypad of the D4591 contains 24 keys consisting of data display 
commands, set-up commands, and a numeric keypad. The display of 
the D4591 is a 2 line by 40-character backlit LCD display that 
displays the selected data and set-up menus. The Keypad/Display can 
be used to view data or adjust the timing and set-up parameters. 
 
 

 
 
The Keypad/Display allows the following to be viewed or adjusted: 
 

1) Set the Bodymaker Parameters 
2) Set the Trimmer Parameters 
3) Set Machine Timing 
4) Set Machine Zero 
5) View the Actual Brake Response (in degrees) 
6) View the Current Shift Data 
7) View the Last Shift Data 
8) View Life Time Stroke Count 

 
The definitions of the keypad commands and menus are described in 
the following sections.  
 
Note:  For virtually all the menus, the “NEXT” and “PREV” keys can 
be used to advance to the next item of the menu or retard to the 
previous item. To change a parameter, simply enter the new value on 
the numeric keypad and press <ENTER>. The value will be entered 
and the next parameter will automatically be displayed. When the last 
parameter is entered, the primary set-up menu is again displayed. 
Pressing <ESC> at anytime will also exit you back to the primary set-
up menu. 
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________________________________________________________ 
3.1 DEFAULT SCREEN 
 
The default screen (displayed when no other commands are active) 
contains the following data: 
 

MACHINE SPEED (SPM):xxxx   POSITION:xxx 
GOOD CANS:xxxxxxx        SHORT CANS:xxxxxx 

 
The “Machine Speed” is the current speed of the bodymaker, the 
“Position” is the current angular position of the bodymaker 
crankshaft, the “Good Cans” field is the total number of good cans 
produced so far into the current shift and the “Short Cans” field is the 
total number of short can faults for the current shift. This display 
effectively replaces a speed meter, a position display and two can 
counters. This screen is always returned to when no other commands 
are active. 
 
 
________________________________________________________ 
3.2 “BRAKE RESPONSE” KEY 
 
This key displays the brake response when a “BDC” stop is 
performed. The response is the number of degrees it takes the press to 
stop from when the clutch is de-activated for a BDC stop to the 
position that the machine comes to rest. This can be used to determine 
the general condition of the brake and whether servicing of the brake 
is required. To exit back to the default screen, simply press the “ESC” 
key. 
 
 
________________________________________________________ 
3.3 “LAST SHIFT” KEY 
 
The Last shift data menu displays the “Total Good Can” count and the 
“Total Short Can” fault count. This data is the totals for the last 
(previous) shift. This data is transferred from the current shift to the 
“Last shift” data when the end of shift input transfers from a “0” to a 
“1”. This can be at the end of either an 8 or 12-hour shift.  
 
Note:  The Current shift “Good Cans” and “Short Cans” is displayed 
as part of the default screen (see section 4.5.1 – Main Display 
Window). 
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The Last shift data is defined as follows: 
 
Good Cans: This is the total number of good cans produced for the 
previous shift. This is essentially a can counter. 
 
Short Cans: This is the total number of short can faults the machine 
had the previous shift. 
 
 
________________________________________________________ 
3.4 “SET-UP” KEY 
 
This selection is used to invoke the primary set-up menu. This 
consists of the following six selections: 
 

1: SET BODYMAKER PARAMETERS 
2: SET TRIMMER PARAMETERS 
3: SET MACHINE TIMING (SET POINTS, ETC.) 
4: ZERO MACHINE (SET RESOLVER OFFSET) 
5: DISPLAY LIFETIME STROKE COUNT 

 
When selected, each of the above selections brings up a sub-menu 
with the corresponding set-up parameters. The following sections 
describe these sub-menus and the definitions of the corresponding 
variables. To select the respective set-up sub-menu, simply press the 
corresponding numeric key (1 through 5). 
 
Note:  The primary set-up menu is protected with an enable switch 
inside the logic compartment of the main control panel.  The “M4500 
Set-up Enable” switch must be in the “Enable” position in gain access 
to the primary set-up menu. 
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________________________________________________________ 
3.4.1 SET BODYMAKER PARAMETERS 
 
This menu is activated when the “1” key (SET BODYMAKER 
PARAMETERS) is pressed while the primary set-up menu is active. 
The following four set-up parameters may then be adjusted or viewed: 
Brake Wear Comp Enable? (0=No, 1=Yes): This prompt is 
used to enable or disable the brake wear compensation. If the 
compensation is to be disabled, enter “0”. If the compensation is to be 
enabled, enter “1”. 
 
Desired BDC Stop POS (Cont./Single): This is the desired 
stopping location (in degrees) for a BDC stop when brake wear 
compensation is enabled. This is typical set to 000 degrees (Back 
Dead Center). This prompt is only displayed when the brake wear 
compensation is enabled. 
 
Maximum Allowed Stopping Response: This defines the 
maximum allowed brake response before a “Brake Response Too 
Long” alarm is generated. If the actual brake response (number of 
degrees from when the brake is activated to the position where the 
press ends up at rest) when a BDC stop is performed is longer than 
this number, the alarm is generated. Set this parameter to the value 
where the brake response is considered too long and service to the 
brake should be performed (typically 270 to 300 degrees). 
 
Running Bodymaker Low Speed (SPM): This is the speed (in 
strokes per minute) the bodymaker will run in low (inch) speed. 
 
Running Bodymaker High Speed (SPM): This is the speed (in 
strokes per minute) the bodymaker will run when in high 
(cont./single) speed. 
 
Number of Strokes before Cupfeed Open:  This is the number 
of strokes (plus 2) the machine will make with air strip once the 
cupfeed is enabled, before it actually opens.  This allows coolant to be 
blown from the ram to prevent “Hydraulic Lock” (normally set to 2). 
 
Number of Cans made with Initial Air Strip:  This is the 
number of cans made using the CH06 – “Initial Air Strip” timing 
channel when the cupfeed is first opened before switching to CH05 – 
“Normal Air Strip”.  This allows the first cans to made with more 
“Air Strip” while the tooling is cool. 
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________________________________________________________ 
3.4.2 SET TRIMMER PARAMETERS 
 
This menu is activated when the “2” key (SET TRIMMER 
PARAMETERS) is pressed while the primary set-up menu is active. 
The following trimmer set-up parameters may then be adjusted or 
viewed: 
 
Trimmer Maximum Speed (CPM): The “Trimmer Maximum 
Speed” parameter is used to scale the 0-10VDC analog output such 
that when the bodymaker is running at the speed entered the analog 
output will be at 10 volts. This is typically set to the running high 
speed of the Bodymaker or slightly higher. 
 
Trimmer Minimum Speed (CPM): This parameter determines the 
speed the trimmer will run at when the bodymaker is stopped (de-
clutched).  
 
Note: When the bodymaker is running, the trimmer speed reference 
is proportional (as set by the “Trimmer Maximum Speed” scaling) to 
the speed of the bodymaker. This parameter is used to provide the 
speed reference when the bodymaker speed is zero. 
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________________________________________________________ 
3.4.3 SET MACHINE TIMING (SET-POINTS, ETC.) 
 
This selection brings up the timing set-point menu, which displays the 
following fields: 
 

CHuu  SETPOINT:xxx   []  “channel name” 
RPM:yyyy    POS:zzz     OFFSET:wwww  SCALE:360 

 
Each field is defined as follows: 
 
Field Definition 
CHuu Currently selected channel (CH00 through CH17) 

where “uu” is the octal channel number. 
 
SETPOINT:xxx Channel “on” or “off” set-point where “xxx” is the 

set-point position 
 
 [] State of channel set-point (blank = “off”, solid 

block character = “on”) 
 
“channel name” selected channel name: (CH00) BDC 

(CONT./SINGLE) TIMING, (CH01) BDC 
(INCH) TIMING, etc. 

 
RPM:yyyy Current machine speed where “yyyy” is in CPM. 
 
POS:zzz Current resolver position where “zzz” is in 

degrees. 
 
OFFSET:wwww Resolver offset where “wwww” is the offset in 

degrees. 
 
SCALE:360 Resolver SCALE FACTOR (360 degrees per 

revolution). 
 
 
In addition to displaying the timing set-point menu, the following keys 
are also enabled: “ENTER SET-POINT”, “CLEAR CHANNEL”, 
“SELECT CHANNEL”, and “SEARCH CHANNEL”. 
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The “ENTER SET-POINT” key is used to enter a new set-point (both 
“on” and “off” set-points) in the selected channel. The “CLEAR 
CHANNEL” key is used to clear all set-points from the selected 
channel. The “SELECT CHANNEL” key is used to select a new 
channel for programming. The “SEARCH CHANNEL” is used to 
view both the “on” and “off” set-points in the selected channel. 
 
Searching Channel: To view the set-points in a channel simply 
press the “SEARCH CHANNEL” key. The next “off” or “on” set-
point is shown in the “SETPOINT” field. The state character [] will be 
a solid block if the set-point is ON or blank if the set-point is off. 
 
Entering or Adjusting Set-point: To set-or adjust a timing 
channel, perform the following: 
 
1) Select the channel to be adjusted by pressing the “SELECT 

CHANNEL” key, entering the channel number (00 to 07) and 
pressing enter. In addition, the “NEXT” and “PREV” keys can be 
used to advance to the next channel or retard to the previous 
channel. 

 
2) Press “CLEAR CHANNEL” to clear out the current channel. 
 

Note:  Entering a new set-point does not automatically clear the 
old set-point out. If the two set-points are not in the same place, 
the channel will simply have two set-points in it if the old one is 
not cleared out first. Therefore, always clear the channel before 
entering a new set-point. A set-point may however, be “extended” 
by programming another set-point onto an existing set-point using 
either the existing “on” or “off” set-point as the starting position 
for the new set-point. This will result in one larger set-point. 

 
3) Press “ENTER SET-POINT” to enter the new set-point. The 

display will then prompt “ON SETPOINT:”. Enter the position (in 
degrees) where the set-point should go “on” and press <ENTER>. 
The display will now prompt “OFF SETPOINT:”. Enter the 
position (in degrees) where the set-point should go “off” and press 
<ENTER>. The channel will now be programmed with a set-point 
that goes “on” at the “on” position entered and “off” at the “off” 
position entered. 

 
4) Return to the primary set-up menu by pressing <ESC>. Return to 

the default screen by pressing <ESC> again. 
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________________________________________________________ 
3.4.4 ZERO MACHINE (SET RESOLVER OFFSET) 
 
To set the machine zero (resolver offset) perform the following: 
 
1) Select “3: SET MACHINE TIMING” and observe the “POS:” 

field. Verify that as the machine is rotated forward (either inched 
or barred) that the position increases linearly from 0 through 359. 
If not, swap the S1 and S3 leads of the resolver cable at the 
M4500 resolver connector. Then verify that the position then 
indeed does increase with forward movement. Press “ESC” to exit 
back to the primary set-up menu. 

 
2) Position the machine at machine zero (back dead center). 
 
3) Auto zero the resolver by selecting “4: ZERO MACHINE” from 

the primary set-up menu. Enter “0” to zero the resolver. The 
timing set-up menu will be displayed, now showing the “POS:” at 
zero. The M4500 will calculate the offset value required to make 
this the 000 position and displays this number in the offset field. 

 
4) Return to the primary set-up menu by pressing <ESC>. Return to 

the default screen by pressing <ESC> again. 
 
 
________________________________________________________ 
3.4.5 DISPLAY LIFETIME STROKE COUNT 
 
The lifetime stroke count is used to display the total number of strokes 
made by the machine.  This register is never reset and displays the 
count in 1,000 can increments 
 
Perform the following to view the lifetime stroke count: 
 
1) Select “5: DISPLAY LIFETIME STROKE COUNT “ from the 

primary set-up menu.  
 
2) The M4500 will automatically display the total lifetime stroke 

count in thousands of cans. 
 
3) Return to the primary set-up menu by pressing <ESC>. Return to 

the default screen by pressing <ESC> again. 
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The set-up program is a Windows based menu driven program, 
allowing the user to easily view data, alter set-up variables or set 
machine timing (machine offset, timing signal locations, etc.), using a 
PC running the Windows™ (95/98/ME/2000/XP) operating system. 
The set-up variables are used to configure and tune the M4500 to 
match the configuration and performance of the specific bodymaker 
(see section 2.7 – HSLW-WI5 Set-Up). 
 
Note:  The set-up program is an on-line communications program 
used to interface with the.  The data displayed and set in the windows 
is communicated directly to the module, while in the “Online” edit 
mode. Therefore, prior to going online with the processor, make sure 
an RS-232 cable is connected from the COM port on the computer to 
the “PROG” of the M4500.  The variables displayed while in the 
“Online” edit mode are read directly from the processor.  Data is 
saved to a “Set-up Data” file (*.sdt) whenever changes are made to a 
parameter or when data is uploaded from the processor. 
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________________________________________________________ 
4.1 GENERAL DESCRIPTION 
 
Title Bar:  At the top of the window is the “Title Bar”.  The title bar 
is used to display the name of the working “Set-up Data” file, as well 
as, the name of the active “Window”.  The title bar is dark if the 
window is active and grayed if another window is active.  The color 
depends on the settings of the Display Properties of the Control Panel. 
 
Status Bar:  At the bottom of the window is the “Status Bar”. The 
status bar is used to display system messages, online or offline mode, 
as well as, the current time and date as set by the operating system.  
The system messages panel displays general information about 
operation of the system.  The Online/Offline mode panel displays the 
status of the current set-up program mode of operation.  The mode of 
operation can be changed by simply double clicking the online/offline 
mode panel. 
 
Hot Keys:  Hot keys are activated by holding down the “ALT” key 
and simultaneously pressing the underlined letter of the desired 
function.  Almost every function can be activated by either pressing a 
series of hot keys or using the “TAB” key to move between fields. 
 
Online/Offline Modes:  The set-up program allows the user to 
make changes while “Online” with the processor.  The “Offline” 
mode is used to preset parameters prior to download.  All functions 
are available to the user while “Online”, however, specific “Online” 
functions are disabled in the “Offline” edit mode. 
 
Note:  Offline changes can only be made by enabling “Offline 
Editing”, accessed from the “Edit” menu. 
 
Getting Help:  The entire contents of the user’s manual is contained 
within the help file.  Pressing Ctrl+H will display the help file 
window.  Pressing the F1 key will display the contents file.  Hot spots 
allow jumps to other topics to display additional information as 
desired.  Selecting “About HSLWI5” from the Help menu will display 
a dialog box listing information about the current revision of the setup 
program and how to obtain technical support. 
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________________________________________________________ 
4.2 THE FILE MENU 
 
The “File” menu allows the user to perform the following functions: 
 
• Create a “New” set-up “Data File”. 
• Open an existing “Data File”. 
• Save any changes made to the current “Data File” to disk. 
• Upload (save) Data from the M4500. 
• Download a SYSdev (.sdv) program to the M4500. 
• Download (restore) Data to the M4500. 
• Print a Report of the current set-up parameters. 
• Exit the set-up program 
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________________________________________________________ 
4.2.1 THE SETUP DATA FILE 
 
The set-up “Data File” (.sdt) is a binary access file, designed for fast 
file I/O operation.  When the set-up program is first invoked, the 
default set-up parameters are loaded into memory.  If changes are 
made to any of the set-up parameters (either online or offline), as well 
as shift data, the user will be flagged to “Save Changes” upon exit of 
the program. 
 
Note:  Any windows based “Set-up” program can open a set-up 
“Data File”, however, the data tables will not be properly aligned. If a 
set-up data file was created by either a different set-up program or a 
different revision of software, the user will be alerted to the problem. 
 
The set-up “Data File” is similar to that of a word processing file.  
When the program first starts a default set of values is loaded and the 
user is able to make any changes as desired.  The set-up program is 
unaware of the parameters that exist within the M4500.  Therefore, to 
normalize the set-up program with the processor, the user should 
define or open an existing file, then upload (save) data from the 
processor.  This allows the user to either create a backup of the data or 
maintain an existing file.  The user can even open a data file for 
another machine, save the file to a new name, make the necessary 
changes and simply download the new parameters to another 
processor. 
 
The following functions can be accessed any time, from any set-up or 
display windows. 
 
New:  To create a “New” data file, select “New” from the “File” 
menu or press “Ctrl + N”.  This creates a completely new file, loaded 
with the default variables and the word “[unnamed]” is displayed in 
the title bar.  If any changes were made to the existing file, the user is 
prompted to save changes prior to exit. 
 
Open:  To “Open” and existing data file, select “Open” from the 
“File” menu or press “Ctrl + O”.  This displays a dialog box, which 
allows the user to navigate and select an existing data file to open and 
the name of the file will be displayed in the title bar.  If any changes 
were made to the existing file, the user will be prompted to save any 
changes first. 
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Save:  To “Save” data file to disk, select “Save” from the “File” 
menu or press “Ctrl + S”.  This displays a dialog box, which allows 
the user to select a folder and enter in a name for the file.  The user 
will be notified if the file name already exists and the extension “.sdt” 
will automatically be added to the file name.  If this is a “New” file, 
the user will be prompted to enter a file name. 
 
Save As:  To save the data file to a new name, select “Save As” 
from the “File” menu..  This displays a dialog box, which allows the 
user to select a folder and enter in a new name for the file.  The user 
will be notified if the file name already exists and the extension “.sdt” 
will automatically be added to the file name. 
 
Export Shift Data…:  This function allows the user to export the 
shift data to a “Tab Delimited” text file.  This allows the user to easily 
use the shift data to produce production reports. 
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________________________________________________________ 
4.2.2 UPLOAD (SAVE) DATA 
 
The “Set-up” program allows the user to upload set-up parameters, 
timing channel set-points and shift data from the M4500 to a set-up 
“Data File”.  This function is accessed from the “File”. 
 
 
________________________________________________________ 
4.2.3 DOWNLOAD PROGRAM 
 
The “Set-up” program allows the user to “Download” any SYSdev 
program file to the M4500. 
 
Note:  To “Download” a SYSdev program to the processor, the 
program must be “Online”.  If “Online” mode cannot be achieved, 
program download will not be executed.  If the program is currently 
“Offline”, the user will be prompted to first go “Online”. 
 
Once selected, and the set-up program “Online” with the processor, a 
dialog box will be displayed, allowing the user to select the SYSdev 
file to download. 
 
Note:  Only the files with the “.sdv” file extension will be displayed.  
It is important to keep in mind that only a valid M4500 PLC SYSdev 
file can be downloaded. Care should be taken when selecting the 
program to download. 
 
Once selected, a message box is displayed informing the user of the 
current program, revision and checksum of the program loaded in the 
processor, as well as, that of the selected program.   
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The user must confirm their selection by clicking the “Yes” command 
button.  After the user confirms their choice, program download is 
initiated and the current program download address is displayed.  
When program download is complete, the user is prompted to 
acknowledge.  Control is passed back to the main program and the 
set-up program remains in an “Online” edit mode. 
 
________________________________________________________ 
4.2.4 DOWNLOAD (RESTORE) DATA 
 
The set-up program allows the user to download  “Set-up” parameters, 
timing channel set-points and shift data to the M4500 from the set-up 
“Data File”.  This function is accessed from the “File” menu. 
 
Note:  Only the values contained within the current data file are used.  
If the validity of the current data file is questionable, review the data 
in an “Offline” mode prior to download. 
 
________________________________________________________ 
4.2.5 PRINT REPORT 
 
The “Set-up” program allows the user to generate a “Report” printout 
of all the set-up parameters, timing channel set-points and shift data 
(of the current set-up file).  This function is accessed from the “File” 
menu. At the top of each page, the report displays the name of the set-
up file, at the bottom of each page is the date and time the printout 
was generated, as well as the page number. 
 
To printout a report of the settings contained in the set-up “Data File”, 
perform the following: 
 
1) From the “File” menu, select “Print Report” or press “Ctrl + P”.   
 
2) The “Print Setup” dialog box will then be displayed, allowing the 

user to select a printer, as well as, the paper size and orientation.  
Once the user selects “OK”, the report is generated and sent to the 
specified printer device.   

 
Note: This function makes use of the windows print manager, which 
allows the user to continue with their work while the document is 
being printed. 
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________________________________________________________ 
4.3 THE EDIT MENU 
 
The “Edit” menu allows the user to perform the following functions: 
 
• Enable/Disable Offline Editing. 
• Set-up the Comm Port. 
 

 
 
 
________________________________________________________ 
4.3.1 ENABLE OFFLINE EDITING 
 
This function allows the user to perform “Offline” editing on the 
currently loaded set-up data file, making any necessary changes to set-
up parameters or timing channels while not online with the processor.   
 
If offline editing is not enabled, the user is only able to view the set-
up and shift data.  When the program is first invoked, the default 
setting is “Offline Editing” - disabled.  The user will need to select 
“Enable Offline Editing” from the edit menu (or press function key 
F2) to enable or disable this feature. 
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________________________________________________________ 
4.3.2 SETUP COMM PORT 
 
This function allows the user to specify the serial communications 
port and rate to talk to the M4500.  The programming port of the 
M4500 is set to 9600 baud.   
 

 
 
Once selected, a dialog box requesting the user to select a “Comm 
Port” and “Baud Rate” will be displayed.  The default setting is 
COM1 at 9600 baud.  
 
In most cases the user will only need to specify the communications 
port and leave the baud rate at 9600.  If communication problems 
occur, make sure there is a secure connection from the PC to the PLC.  
Then check the Comm port.  In most cases the user will only need to 
select a new Comm port.  If communication problems persist, there 
may be another program causing a conflict with the port.  Check the 
port configuration from the “Settings” folder. 
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________________________________________________________ 
4.4 THE VIEW MENU 
 
The “View” menu allows the user to perform the following functions: 
 
• View the “Target Board Interface” 
• View “Online” Data 
• View “Offline” Data 
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________________________________________________________ 
4.4.1 TARGET BOARD INTERFACE 
 
This function allows the user to view fault codes, S3000 network 
communication error codes and review the current “Ident” and 
“Revision” of the application program.  This is accessed by the 
“View” menu, by selecting “Target Board Interface”. 
 

 
 
Once invoked, the set-up program will prompt the user to select a 
program to compare with the one existing in the processor.  Whether a 
program is selected or the user cancels, the setup program will attempt 
to communicate with the M4500.  If unsuccessful, a warning message 
will be displayed, prompting the user to either “Retry” or “Cancel” the 
operation.  If the operation is canceled and communication with the 
processor cannot be established the system will be placed in an 
“Offline” mode, however the “Target Board Interface” window will 
be displayed. 
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________________________________________________________ 
4.4.2 VIEW ONLINE DATA 
 
This function allows the user to place the set-up program in an 
“Online” mode with the processor.  This is accessed by the “View” 
menu, by selecting “Online Data” or by simply pressing the “F3” 
function key. 
 
Note:  The program can be toggled between “Offline” and “Online” 
by simply double clicking on the “Online” or “Offline” panel 
displayed in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will attempt to open the Comm port 
and communicate with the M4500.  If the set-up program is 
unsuccessful, a warning message will be displayed prompting the user 
to either “Retry” or “Cancel” the operation.  If the operation is 
canceled and communication with the processor cannot be established 
the system will be placed in an “Offline” edit mode. 
 
Note:  Anytime while the set-up program is “Online” with the 
processor and communication is interrupted, a warning message will 
be displayed, prompting the user to either “Retry” or “Cancel” the 
operation. 
 
 
________________________________________________________ 
4.4.3 VIEW OFFLINE DATA 
 
This function allows the user to place the set-up program in an 
“Offline” mode.  This is accessed by the “View” menu, by selecting 
“Offline Data” or by simply pressing the “F4” function key.  This 
allows the user to perform “Offline” editing.  All values displayed in 
“Offline” edit mode reflect the actual values contained in the currently 
loaded set-up data file. 
 
Note:  The program can be toggled between “Online” and “Offline” 
by simply double clicking on the “Online” or “Offline” panel 
displayed in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will close the Comm port and cease 
communication with the M4500. 
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________________________________________________________ 
4.5 THE WINDOW MENU 
 
The “Window” menu allows the user to select one of five different 
Display/Set-up windows to modify set-up parameters, view shift data 
or receive feedback about the current status of the control system. 
 

 
 
Once a window menu item is selected, a check mark is placed next to 
the selected item and the selected window is displayed with the name 
changed in the title bar of the main window. 
 
Note:  “Read” only variables are displayed in blue with a gray 
background.  Any variables that can be altered by the user are 
displayed in black with a white background.  In most cases, a 
parameter that can be changed by the user will have associated with it 
increment and decrement controls.  The user can either click on the 
desired parameter to adjust and enter in a new value, or use the 
increment or decrement controls to change the value by 1 unit. 
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________________________________________________________ 
4.5.1 THE MAIN DISPLAY WINDOW 
 
The “Main Display” window is used to display the general state of the 
control system.  This window is selected from the “Window” menu. 
 

 
 
The following is a list of the functions of the “Main Display” window. 
 
Messages:  The “Messages” display is continuously updated.  It 
displays alarm and status messages specific to the M4500, as well as, 
the current “Online” or “Offline” status of the set-up program. By 
simply scrolling the display, the user is able to view all active alarm 
and status messages.  If no alarm or status messages are active, a 
default message is displayed. 
 
Machine Speed SPM:  This display is only active while “Online” 
and displays the current speed of the machine in “Strokes Per 
Minute”. 
 
Machine Position:  This display is only active while “Online” and 
displays the current position to the main crank resolver in degrees.. 
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________________________________________________________ 
4.5.2 THE SETUP PARAMETERS WINDOW 
 
The “Set-up Parameters” window is used to view and adjust the set-up 
parameters.  This window is selected from the “Window” menu. 
 

 
 
Canfeed Open/Initial Airstrip Strokes: 
 
Number of Strokes before Cupfeed Open:  This is the number 

of strokes (plus 2) that the machine will make with air strip, once 
the cupfeed is enabled, before it actually opens.  This allows 
coolant to be blown from the ram to prevent “Hydraulic Lock” 
(normally set to 2). 

 
Number of Cans Made with Initial Air Strip:  This is the 

number of cans made using the CH06 – “Initial Air Strip” timing 
channel when the cupfeed is first opened before switching to 
CH05 – “Normal Air Strip”.  This allows the first cans to made 
with more “Air Strip” while the tooling is cool. 
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Brake Wear Compensation: 
 
Brake Wear Compensation Enable:  This is used to enable or 

disable the brake wear compensation. If the compensation is to be 
disabled, click the checkbox to remove checked state. If the 
compensation is to be enabled, click the checkbox to set the 
checked state. 

 
Desired BDC Stop Position (Cont./Single):  This is the desired 

stopping location (in degrees) for a BDC stop when the brake 
wear compensation is enabled. This is typical set to 000 degrees 
(Back Dead Center). 

 
 Note:  This parameter is automatically disabled whenever “Brake 

Wear Compensation” is disabled. 
 
Maximum Allowed Stopping Response:  This defines what the 

maximum allowed brake response is before the “Brake Response 
Too Long” alarm is generated. If the actual brake response 
(number of degrees from when the brake is activated to the 
position where the press ends up at rest) when a BDC stop is 
performed is longer than this number, the alarm is generated. If 
the actual brake response is less, the alarm is not generated. Set 
this parameter to the value where the brake response is considered 
too long and service to the brake should be performed (typically 
270 to 300 degrees). 

 
Trimmer Speed References: 
 
Trimmer Maximum Speed (CPM):  The “Trimmer Maximum 

Speed” parameter is used to scale the 0-10VDC analog output 
such that when the bodymaker is running at the speed entered in 
“Trimmer Maximum Speed”, the analog output will be at 10 volts. 
This is typically set to the running high speed of the Bodymaker or 
slightly higher. 

 
Trimmer Idle Speed (CPM):  This parameter determines the speed 
the trimmer will run at when the bodymaker is stopped (de-clutched).  
 
Note:  When the bodymaker is running, the trimmer speed reference 
is proportional (as set by the “Trimmer Maximum Speed” scaling) to 
the speed of the bodymaker. This parameter is used to provide the 
speed reference when the bodymaker speed is zero. 
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Bodymaker Running Speeds: 
 
Running Bodymaker Low Speed (SPM):  This is the speed (in 

strokes per minute) the bodymaker will run when in low (inch) 
speed. 

 
Running Bodymaker High Speed (SPM):  This is the speed (in 

strokes per minute) the bodymaker will run when in high 
(cont./single) speed. 

 
 
________________________________________________________ 
4.5.3 THE MACHINE TIMING WINDOW 
 
The Machine Timing window is used to invoke the PLS programming 
command menus.  From this window, the user can view or adjust the 
following parameters: 
 
• Adjust Timing Channel set-points. 
• Set the Main Crank resolver offset. 
• Clear or Recall a PLS timing channel. 
• View the current PLS configuration 
• Reset the PLS configuration to default settings. 
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In addition, the following parameters are displayed at the bottom of 
this window: 
 
RPM:  This is the current speed in “Revolutions per Minute” of the 
main crank resolver. 
 
Position:  This is the current “Position” in degrees of the main crank 
resolver. 
 
Offset:  This is the current resolver offset (set in degrees). 
 
Scale:  This is the scale factor of the resolver or the number of 
divisions in one revolution. 
 
Note:  Section 5 – General Timing Signal Locations, provides a 
complete description of each timing channel signal. 
 
Zeroing Machine (set resolver offset):  To set machine zero, 
perform the following: 
 
1) From the “Window” menu, select “Machine Timing”. 
 
2) From the “View” menu, select “Online Data”.  The set-up 

program will attempt to communicate with the processor and place 
the system into an “Online” mode of operation. 

 
3) Observe the “Position” field at the bottom of the window.  Verify 

that as the machine is rotated forward, that the position increases 
linearly from 0 through 359 degrees.  If not, swap the S1 and S3 
leads at the resolver connector on the M4500.  Then, verify that 
the position does indeed increase with forward movement. 

 
4) Position the machine at back dead center. 
 
5) Auto zero the resolver by entering “0” in the “Resolver Offset” 

field and clicking the “Set Offset” command button.  A message 
box will appear, prompting the user to confirm their choice.  
Select “Yes” to set the resolver offset. 

 
6) The M4500 will calculate the actual offset value required to make 

this the “0” position.  The new offset value will be displayed in 
the “Offset” filed and the position will then read zero. 
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Adjusting the Timing Channel Set-points:  To set any of the 
timing signal set-points, perform the following: 
 
Note:  Any changes made to the timing channel set-points will be 
saved as part of the setup data file. 
 
1) From the “Window” menu, select “Machine Timing”. 
 
2) From the “View” menu, select “Online Data”.  The set-up 

program will attempt to communicate with the processor and place 
the system into an “Online” mode of operation. 

 
3) Set all channels per section 5 – General Timing Signal Locations.  

Set-points for a particular channel are either entered in the field or 
adjusted by using the increment/decrement controls. 

 
Note:  Only one set-point is used per channel.  

 
4) If a channel needs to be “Recalled” or “Cleared”, enter the desired 

channel number into the “PLS Channel” field.  Click the “Recall 
Channel” command button to recall the set-points.  Click the 
“Clear Channel” command button the completely clear all set-
points for the selected channel. 

  
Note:  If a channel has been cleared or the “On” and “Off” set-
points have the same setting, the set-point will be displayed as 
“*****”. 

 
Resetting the PLS Configuration:  As an aid to the user the 
current PLS configuration is displayed as part of this window.  The 
PLS configuration should only need to be reset if a new module has 
been installed.  To reset the PLS configuration, click the “Reset PLS 
Config” command button.  This function only resets the PLS 
configuration to the default settings for the bodymaker. 
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________________________________________________________ 
4.5.4 THE SHIFT DATA WINDOW 
 
This window is used to view the Current Shift data, Last Shift data, 
Low and High speed brake responses and to invoke the “End of Shift” 
data transfer. 
 

 
  
Note:  Prior to selecting this selection, make sure an RS-232 SYSdev 
cable is connected from the COM port on the computer to the PROG 
port on the M4500. The following data is displayed in this window: 
 
Current Shift - Total Good Cans: This is the total number of 
good cans produced so far into the current shift. This is essentially a 
can counter. 
 
Current Shift - Total Short Can Faults: This is the total number 
of short can faults that have occurred so far into the current shift. 
 
Last Shift - Total Good Cans: This is the total number of good 
cans produced in the last (previous) shift. This is essentially a can 
counter. 
 
Last Shift - Total Short Can Faults: This is the total number of 
short can faults that occurred in the last (previous) shift. 
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Note: The current shift data is transferred to the “Last shift” data 
when the end of shift input transfers from a “0” to a “1”. This can be 
at the end of either an 8 or 12-hour shift. This data can also be reset 
from this menu by clicking the “Transfer Data” command button. 
 
Lo Speed Brake Response (degrees): This is the number of 
degrees from the when the clutch was de-activated (at the BDC (Lo) 
timing) to where the bodymaker crankshaft came to rest when a BDC 
stop was performed at Low speed. This can be used to determine the 
general condition of the brake and whether servicing of the brake is 
required. 
 
Hi Speed Brake Response (degrees): This is the number of 
degrees from the when the clutch was de-activated (at the BDC (hi) 
timing) to where the bodymaker crankshaft came to rest when a BDC 
stop was performed at high speed. This can be used to determine the 
general condition of the brake and whether servicing of the brake is 
required. 
 
Note:  The brake response for both high and low speeds is updated 
after each BDC stop. 
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________________________________________________________ 
4.5.5 THE I/O STATES WINDOW 
 
The “I/O States” window is provided to display states of the inputs 
and outputs.  The control boards, the states of the timing channels, as 
well as states of the M4500 are shown.  This includes the interrupt 
inputs (IN0 and IN1), the analog I/O and the resolver.  These values 
are displayed as read by the M4500 processor. 
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The following is a general description of the timing signals and the 
locations they should be set at: 
 
CH00: BDC (Cont./Single) Timing: This signal is used to de-

activate the clutch for a BDC stop at high speed (continuous 
and single modes).  

 
Note: The leading edge is used to de-activate the clutch, 
thus the width of the signal is not critical (generally set 20° 
wide). When the brake wear compensation is enabled, this 
signal is adjusted automatically by the M4510. If the brake 
wear compensation is disabled, this signal must be set 
manually. In this case is should be set such that the press 
stops at back dead center for a BDC stop at high speed. 

 
CH01: BDC (Inch) Timing: Same as the BDC (Cont./Single) timing 

(CH00) except used when the machine is activated in “Inch” 
mode. 

 
CH02: Short Can Timing: This signal is used to verify the length 

of the can and verify that the can is good. The short can 
sensor must “see” can the entire time this signal is “ON” to 
prevent a short can alarm. This signal is generally set in the 
range of “on” at 150° to 160°  and “off” at 170° to 175°. 

 
CH03: Sensor Check Timing: This signal is used to verify that the 

short can sensor does not fail “ON”. The short can sensor 
must be “off” the entire time this signal is “on” in order to 
prevent a  “Die Sensor Fail” alarm. This signal is generally 
programmed to be “ON” just prior to the punch emerging 
from the die set, on the forward stroke (typical “ON” at 110° 
and “off” at 130°). 

 
CH04: Cupfeed Timing: This signal is used to activate the cupfeed 

“ON” when enabled and back “off” when disabled. The 
leading edge of this signal is used to activate the solenoid 
“on” while the trailing edge is used to activate it “off”. The 
“ON” set-point is generally set such that when the cupfeed is 
opened, the cup will drop onto the high part of the rotary 
cam. The “off” set-point is generally set such that the 
cupfeed will close such that the cup is caught with-out 
causing damage to the cup that is retained. This signal is 
generally set “ON” at 150° and “off” at 350°. 
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CH05: Air Strip (Normal) Timing: This signal is used to activate 
the air strip solenoid once the machine has established 
“Normal” production. The “Air Strip” is “ON” for the entire 
window that CH05 is “on” while the machine is running 
with the cupfeed open. This signal is generally set “ON” 
about 150° and then set “off” at about 200° (see section 
2.7.8). 

 
CH06: Air Strip (Initial) Timing: Same as the Air Strip (Normal) 

timing (CH05) except used when the machine is first 
initiated into production (see section 2.7.8). This is generally 
set “ON” about 120° and then “off” at about 190°. 

 
CH07: PLC Clock Timing: This is a general purpose, timing signal 

available for use by existing PLC for whatever purposes 
necessary. This signal is not used by the M4500. 
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The Following are recommended spares for the HSL-WI5. These parts 
are available through Systems Engineering Assoc. Inc. 
 
 
 Quantity Part Number Description 
 

1ea. M4500 PLC/PLS Processor/Chassis – 4 
Slot 

1ea. P4500 Power Supply 
1ea. S4563 16-point, 10-30VDC Input Board 
1ea. S4573 16-point, 10-30VDC Output Board 
1ea. D4591 Keypad/Display 
1ea. RSV34-MS1 Resolver with MS Connector 
 

 
 


